Leisure Suit Larry: Love for Sail!
First Time Installation

Windows® 95
1. Start Windows® 95.
2. Insert the Love for Sail® disk into your CD-ROM drive. Enjoy!
   If you've disabled AutoPlay, press the [Start] button, select [Run].
3. Type “D:SETUP” and press [ENTER].
   (If your CD-ROM drive is not named “D,” substitute its letter instead.)

Windows® 3.x
1. Start Windows®.
2. Insert the Love for Sail® disk into your CD-ROM drive.
3. Go to Program Manager. From its [File] menu, select [Run].
4. Type “D:SETUP” and press [ENTER].
   (If your CD-ROM drive is not named “D,” substitute its letter instead.)

DOS
1. Insert the Love for Sail® disk into your CD-ROM drive.
2. At the DOS prompt, type “D:” and press [ENTER].
   (If your CD-ROM drive is not named “D,” substitute its letter instead.)
3. Then type “CDV” and press [ENTER].
4. Then type “INSTALL” and press [ENTER].
The Start Up Screen

The first time you play Love for Sail! you'll skip the Start Up screen and get right "into the action." So don't go looking for it. Don't worry. You'll get to see plenty of it soon enough!

Resume Your Previous Game
Click this to be placed right back in the game right where you were the last time you quit. Pretty handy, no? Of course, if you haven't Quit, you can't Resume. (Duuh!)

Open an Existing Game
Click this to resume a different saved game. Of course, if you haven't Saved, you can't Open.

Start A Brand New Game
Click this to start a new game from the very beginning. You'll lose your previous game, you know. This time, try listening to the Swedish Fire Chief!

Visit the Larry Web Site
Click here and your Web browser might just launch and take you to the Leisure Suit Larry web site. (If it doesn't, try www.sierra.com/games/lsl7 on your own.)

Lemme Outta Here! (Exit)
Click this and...oh, just take a wild guess!

The Menu Bar

Move your cursor to the upper-left corner of the game's graphics area and a menu bar appears. (If your screen is larger than the game window, be sure to stay inside the game window and below the title bar.) Select an action from the menu. Most work exactly like other menus you know and love. Try 'em all...at least once. Some will bring you back again and again, screaming with delight!

The File Menu

New starts a new game. (Duuh.) You probably won't use this much, but the File Menu looked all naked without it.

Open restores a previously saved game. If you haven't saved your game, this function is pretty much worthless.

Save saves your current position. But you don't really need this in Love for Sail! because you can't die and you can't get trapped. The newer, easier method is to just Quit the game. We'll save your place automatically. Then Resume and you're right back where you were. But, we kept Save around just in case you want to mark some fun spots. Hint: when entering the save game's description, Ctrl-C quickly Cuts away the old description.

Quit is the proper way to leave the game. Your position is saved automatically, so the next time you start, you can just select "Resume" on the Start Up screen and you'll be returned to right where you were. Note: exiting any other way does not save your current position. Better hope you saved!
The Game Menu

Map takes you to the ship's map. For more information, see “Game Controls” below.

Inventory brings up the inventory window. For more information, see “Game Controls” below.

Score tells you how you're doing. It's also on the right mouse-click shortcut menu.

Audio Mixer lets you adjust the relative volume levels of the game's background music, dialogue, and sound effects. Don't like our mix? Think you can do better? Fine! Do your own. (Screw it up? Click “Default.”)

Boss is Coming... Oh, take a wild guess!

Walking Speed lets you change how fast Larry walks.

Increase Filtch Level makes the game much more rancid.

Decrease Filtch Level makes the game much less rancid.

Ship Stabilizer stops the “motion of the ocean” outside the ship's portholes.

Closed Captioning turns the sub-titles at the bottom of the screen on and off. Highly recommended for airplane flights when you forget your headphones.

The Help Menu

Serious help is available in a variety of locations: hint books, telephone, fax, on-line services, web sites, etc. See “How to Contact Sierra” on page 20.

Help offers a few suggestions about how to get started playing adventure games.

Hints does almost nothing.

Customer Service gives you current telephone, fax, and email numbers for Sierra worldwide.

About... WARNING: NEVER TRY THIS! Also: do not pause your cursor over the team members' faces.
Game Play

The Cursor
The "packaged cursor" means the game is presently busy. Wait a while and the special "Larryesque" cursor will appear. Move it around. When it's not highlighted, clicking it makes Larry walk as close as possible to where you clicked. But when it does "highlight" (in its own inimitable way), you've found something interactive. Then you should...

Left Click
When the cursor is highlighted, a left click displays a context-sensitive menu of verbs unique to that object. Try them all, including "Other...", which means...

Typing
Selecting "Other..." lets you type in your own verbs. Typing is important in Love for Sail! Some puzzles can only be solved by typing. But all you need type is the verb. Nouns aren't necessary. (You clicked on the noun, remember?) And you usually only need to type one word. We save the most recent few for you, so you don't have to re-type them. And like Mrs. Bradley tried to tell you in third grade, spelling does count.

Talking
Talking to people produces a varying menu of topics. Again, "Other..." lets you type in topics of your own. Here it's the verb that's unnecessary. All you need is the (usually) one-word topic. Remember, some puzzles can only be solved by typing. Note: Topics change color when you hear them (for example, "Telephone" in the illustration). You never need to listen to a topic a second time, unless you just forgot to take notes the first time!

CyberSNIFF 2000™
Do not become alarmed when you see (and hear!) the CyberSNIFF 2000™ logo. Do not run screaming from your home. No, it's just the latest in multi-multi-media as Love for Sail! tickles yet another of your senses. When the CyberSNIFF 2000™ logo appears at the bottom of your screen, carefully remove your CyberSNIFF 2000™ card from its jewel-encrusted case... (What? Oh.) Sorry... from the CD's jewel box case. Gently rub your fingernail once across the colored square matching the number shown. Then, stick your nose in it... and enjoy!
Right Click Shortcuts

Right clicking anywhere provides a convenient list of shortcuts to common menu items. Sure, you *could* use the regular pull-down menus, but this way it’s easy to do the things you do the most.

The Map

Once you board the PMS Bounty, you receive a map of the ship. It’s the quick and easy way to move through the game. No more walking around. From the pull-down Game menu, select Map, or use your right-click shortcut menu. Move the cursor around the ship until it’s over where you want to go. Click and “Poof!” You’re there.

Inventory

The Inventory Window is where you use the objects you find. From the pull-down Game menu, select Inventory, or use the right-click shortcut.

Taking Objects: Sometimes when you click on an object, its menu includes “Take.” Take it—you’ll be glad you did. The object you took then appears in your Inventory window and in the “Use...” list.

Using Objects: To use an object you’ve taken, first click an on-screen object. Then, from its resulting menu, select “Use...”. Slide your mouse over and down until it’s over the object you want to use. Click. *Hint:* first select the on-screen object to receive the action, then select the Inventory object to be used. *Example:* to use the banana on the toilet seat, first click the toilet. Then, from the toilet’s “Use...” menu, select “Banana.”

Manipulating Objects: Some objects may be manipulated in the Inventory window. Check each inventory item carefully. Some conceal important information! Try ‘em all!

Combining Objects: Some Inventory objects may be combined with other Inventory objects to create new Inventory objects. To do this, go to the Inventory window. Left click on an object. From its menu, select “Use...”. Slide your mouse over and down until it’s over the object you want to use. Click. *Hint:* it works exactly like the game: first select the on-screen object, then select the Inventory object to use on it. *Example:* to rub the banana on the cattle prod, first click the cattle prod. Then, from the cattle prod’s “Use...” menu, select “Banana.”
Strategy

Love for Sail! is a game of exploration. So don't miss anything! Look at each new scene carefully. Click on anything that causes your cursor to highlight. Try all the menu choices. Talk to everyone you see. Take notes. Remember what they say, as it may come in handy later as something to talk about with one of your new friends.

Things change during the course of the game. New characters may appear. Keep looking around.

Think creatively. When you get "stuck," leave and explore other areas. You never know where you might find just what you need. Above all, relax, let your imagination run wild, and have fun!

Be A Star!

Love for Sail! is the first computer game in history to put you on-screen and in the action. Just follow the steps below. Of course, if any of this doesn't make sense to you, you're probably just not ready to "be a star!"

CyberSCAN 2000™

Want to see your face on-screen? Here's how: scan a picture of your face and save it as a 256-color BMP file in your Larry sub-directory. Name it 1.BMP. See the BEASTAR.TXT file in that sub-directory for more information. Hint: for best results, crop the file so it's mostly your face.

CyberVOX 2000™

Want to act? Want a role as the off-screen waiter? Use your Windows-supported sound card and microphone to add your voice to Love for Sail! Here's how: go to the Larry sub-directory. Open a file named VOICE.TXT in Notepad. It contains your script and further instructions. Also run Sound Recorder (or whatever you use to record voice files). Position both programs' windows side-by-side so you can read your lines in Notepad while recording your dialog. Be funny!

CyberSYSTEM 2000™

Set your Windows wallpaper to LARRY7.BMP in the Larry sub-directory. Then, as you make progress in the game, we'll update your wallpaper to reflect your "latest conquest." Note: Windows only loads your wallpaper as it starts up, so you may not see it change until tomorrow.

CyberSOUND 2000™

Add your own sound effects? Sure! Maintaining the tradition of recent Leisure Suit Larry games, Love for Sail! lets you "improve" the game at the touch of a (Bodily) Function Key. Try 'em all! Amuse your friends. Enjoy!
Credits
Team Larry

Designer, Writer, Director
Al Lowe

Producer
Mark Seibert

Assistant Designer & Writer, Programmer
Don Munsil

Animation Director
Jason Zayas

Lead Programmer
Steve Conrad

Programmer
Mark Martino

Background Design
Jason Piel

Lead Background Artist
Layne Gifford

Animators
Bill O'Brien
Al Eufrazio

Art Technicians
Bob Munsil
Bryan Wilkinson

Quality Assurance Lead
Jennifer Gibbs

Sound FX & Additional Music
Ben Houge
Mark Seibert

Voice Director
Al Lowe

Voice Casting
Al Lowe & Don Munsil

Voice Auditions
The Voicecaster,
Burbank, California

Voice Recording
Hollywood Recording Services

Voice Recording Engineer
Mike Hanley

DREAMS Software Specialist
David Henry

Background Photographer
Al Lowe

Best Buy
Dale Christensen

Leisure Suit Larry theme
composed by
Al Lowe

Additional Credits

Leisure Suit Larry theme
arranged by
Frank Zottoli

Original music composed by
Frank Zottoli

Original music performed by
Frank Zottoli, Piano
Kim Hutchcroft, Woodwinds
Tom Warrington, Bass
Claudio Sloan, Drums
Mark Seibert, Guitar
Synthesizers, Percussion
Al Lowe, Soprano Saxophone
Steve Conrad, Trombone

Original music recorded at
Chick Corea's Mad Hatter studios,
Hollywood, California

Original music engineered and mixed by
Jeff Hall

Original music mixed at
Maximus Studios,
Fresno, California
Configuration Testing by
Michael D. Jones and the entire Sierra
Oakhurst Quality Assurance Team

Beta Testers
Geoff M. Keighley
Linda Lindley
Wesley Litt
Tim Marley
Dan Milano
Steve Porter
Della Rogers
Mark Schey
Michael Shavelson
Charles M. Solen

Packaging and Documentation
Heather Lavin
Kerri Willard

Special Thanks To
Terese Gant
Colette Bottinelli
Cindy Vanous
John Williams
Eric Twelker
Bill Moore
Scott Lynch
Jerry Bowerman
Mike Brochu
Ken Williams
Roberta Williams
Walter Forbes

Zippy the Inflatable Wonder Llama
The World Famous Talking Bear
...and all the moms, dads,
husbands, wives, girl friends,
boyfriends, & significant others
without whom this game would have
been done months earlier.

Supervising Animators
David Hicock & Larry Royer

Key Animation
David Hicock
Larry Royer
John Bloom
Bill Davis
Marcus R. Gregory
Fran Krause

Paint Coordinator
Jennifer Robin

Computer Ink & Paint
Jennifer Darsney
Marcus R. Gregory
Frank Krause
W Aric Miller
Jennifer Robin
Peter Wynn

Animation
Jim Burns
Julie Cornfield
Jennifer Darsney
Aaron P McDowell
Matthew S Filer
Jose Mercado
W Aric Miller
Jon C Parker
Jeff Whitaker
Michael Pringleton
Jennifer Robin
B J Walker
Guillermo Zubiaga
Animation Credits, LA West

Director of Animation
Ivan Tomicic

Project Coordinator
Susan McGirr

Production Assistant
Danijel Tomicic

Animation Team Leaders
Jurica Saravanja
Ivica Horvat

Animators
Jurica Saravanja
Danir Semenov
Zvonimir Cutk
Ivica Horvat
Kristan Dulic
Zeljko Bracic

Digital Ink & Paint
Computer Artist Lead
Peggy Skrlec

Digital Ink & Paint
Computer Artists
Sasa Zece
Snjezana Lisica
Peggy Skrlec
Darko Dukaric
Ivana Baric
Scanner
Snjezana Lisica

The Cast

Leisure Suit Larry .................................. Jan Rabson
Narrator ............................................ Neil Ross
Dewmi Moore ....................................... Sheryl Bernstein
Drew Baringmore .................................. Mary Kay Bergman
Mysterious Woman in Black ......................... Tasia Valenza
Victorian Principles ................................ Jocie Carlisle
Jamie Lee Coitus .................................... Mary Kay Bergman
Nairini Jugg ........................................... Herself
Wydoncha Jugg ....................................... Mary Kay Bergman
Peggy ................................................. Sheryl Bernstein
Captain Thygh ....................................... Julie Amato
Shamara .............................................. Scott Bullock
Peter .................................................. Kevin Richardson
Johnson .............................................. Scott Bullock
Dick ................................................... Michael Golff
Jacques .............................................. Scott Bullock
Wang .................................................. Michael Golff
Willy ................................................. Michael Golff
Mr. Boning .......................................... Neil Ross
Xuestos .................................................. Neil Ross
Judge Graham ....................................... Kevin Richardson
Judge Julia .......................................... Sheryl Bernstein
Judge Paul ........................................... Kevin Richardson
Rod ................................................... Tasia Valenza
Female Ship's Announcer ................. Tasia Valenza
Male Ship's Announcer ......................... Neil Ross
How to Contact Sierra

Technical Support

AUTOMATED TECHNICAL SUPPORT LINE
(206) 644-4543

IN THE U.S.
Sierra On-Line
Technical Support
P.O. Box 8506
Bellevue, WA 98005-8506
Main: (206) 644-4343
Fax: (206) 644-7697
8:15 am - 4:45 pm PST
Monday - Friday

IN THE U.K.
Sierra On-Line Limited
4 Brewery Court
The Old Brewery
Theale, Reading, Berkshire, RG7 5AJ United Kingdom
Main: (44) 1-734-303-171
Monday through Friday,
9:00AM - 5:00PM
Fax: (44) 1-734-303-362

IN FRANCE
Parc Tertiaire de Meudon
Immeuble "Le Newton"
25 rue Jeanne Bracconier
92366 Meudon Le Forêt Cedex
France
Main: (33) 1-46-01-46-50
7 jours sur 7 de 9h à 21h
Fax: (33) 1-46-30-00-65

IN GERMANY
Sierra Coltel Deutschland
Robert-Bosch-Str. 52
D-63034 Dreieich
Germany
Main: (49) 0-6103-99 40 40
Montag bis Freitag von 9-19h
Fax: (49) 0-6103-99 40 35
Mailbox: (49) 0-6103-99 40 41

IN SPAIN
Coltel Educative Multimedia
C/ Tomas Redondo, 1-1ª F
Edificio Luarca
28035 Madrid
Spain
Main: (34) 1-764-39-69
lunes a viernes de 9h30 a 14h y
de 15h a 18h30
Fax: (34) 1-381-08-39

MODEM SUPPORT
Internet: http://www.sierra.com
Sierra U.K. BBS: (44) 1-734-30-4227
Compuserve: GO SIERRA
America Online: Keyword SIERRA

Direct Sales

U.S. DIRECT SALES
Sierra Direct
7100 W. Center Rd
STE 301
Omaha, NE 68106
Main: (800) 757-7707
Mon - Sat: 7AM to 11PM CST
Sundays: 8AM to 9PM CST

IN FRANCE
Parc Tertiaire de Meudon
Immeuble "Le Newton"
25 rue Jeanne Bracconier
92366 Meudon Le Forêt Cedex
France
Main: (33) 1-46-01-48-53
lundi au vendredi de 9h à 18h
Fax: (33) 1-46-30-00-65

ON-LINE SALES
Compuserve:
GO SI (C Serve Mall)
America Online:
Keyword: SIERRA
Internet: http://www.sierra.com

US DISK/DOCUMENTATION REPLACEMENT & RETURNS
Disk/Documentation Replacement:
Sierra On-Line Fulfillment
PO Box 485
Coeur d'Alene, ID 99114

Product Returns:
Sierra On-Line Returns
PO Box 485
Coeur d'Alene, ID 99114

International Support Services

INTERNATIONAL SALES
Sierra Direct
7100 W. Center Rd
STE 301
Omaha, NE 68106
For direct orders: (206) 746-5771
Fax: (402) 392-9117

20

21
ON-LINE HINTS & SUPPORT
Access Sierra's Hints through CompuServe by typing: GO SIERRA then go to Hint Connection
Access the Sierra Forum on America Online with the keyword: SIERRA

FRANCE HINT LINE
36-68-46-50 (hint line)
2.23€ TTC la minute; tarif en vigueur au 1 juillet 1996
(France métropolitaine seulement).

GERMANY HINT LINE
0190-515 616
Kosten: 1,20 DM pro Minute
(Nur in Deutschland verfügbar)

U.K. HINT LINE
Old Games Hint Line: (0) 1-734-30-4004
(within the UK)
Old Games Hint Line: (44) 1-734-30-4004
(outside the UK)
New Games Hint Line: (0) 8-91-66-0660
(within the UK only)

NEW SIERRA HINT LINE:
For adventure games released after January 1, 1993. Charged 39p/minute cheap rate, 49p/minute at other times. Maximum call length: 7.5 minutes. Maximum charge cheap rate: £2.93, £3.68 other times. Must have permission of the person who pays the phone bill before calling (line available in the UK only, 24 hours. Requires a touch tone phone).

SPAIN HINT LINE
Cotel Educativa Multimedia
C/ Tomas Redondo, 1-1º F
Edificio Luarca
28033 Madrid
Spain
Tel: (34) 1-764-39-69 (lunes a viernes de 9h30 a 14h y de 15h a 18h30)
Fax: (34) 1-381-08-39

ITALY HINT LINE
Contact your local vendor.
The Sierra No-Risk Guarantee

The Promise: We want you to be happy with every Sierra product you purchase from us. Period. If for any reason you're unhappy with the product, return it within 30 days for an exchange or a full refund— even if you bought it retail.

The Only Catch: You've got to tell us why you don't like the game. Otherwise, we'll never get better. Send it back to us and we promise we'll make things right. (If you bought it at a retail outlet, please send your original sales receipt.)

Warranty

IMPLIED WARRANTIES LIMITED:
EXCEPT AS STATED ABOVE, SIERRA MAKES NO WARRANTY, EXPRESS OR IMPLIED, REGARDING THIS PRODUCT. SIERRA DISCLAIMS ANY WARRANTY THAT THE SOFTWARE IS FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLIED WARRANTY OF MERCHANTABILITY SHALL BE LIMITED TO THE NINETY (90) DAY DURATION OF THIS LIMITED EXPRESS WARRANTY AND IS OTHERWISE EXPRESSLY AND SPECIFICALLY DISCLAIMED. SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

NO CONSEQUENTIAL DAMAGES:
SIERRA SHALL NOT BE LIABLE FOR SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF SIERRA IS ADVISED OF OR AWARE OF THE POSSIBILITY OF SUCH DAMAGES. THIS MEANS THAT SIERRA SHALL NOT BE RESPONSIBLE OR LIABLE FOR LOST PROFITS OR REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A RESULT OF LOSS OF TIME, DATA OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE EXCEPT THE ACTUAL COST OF THE PRODUCT. IF ANY EVENT, SIERRA'S LIABILITY EXCEED THE PURCHASE PRICE OF THE PRODUCT. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

You are entitled to use this product for your own use, but may not sell or transfer reproductions of the software manual or book to other parties in any way, nor rent or lease the product to others without prior written permission of Sierra. You may use one copy of the product on a single terminal connected to a single computer. You may not network the product or otherwise install it on more than one computer or computer terminal at the same time.
Front Row: Al Eufrasio, Mark Martino, Jennifer Keenan, Bill O’Brien, Jason Zayas, Mark Seibert, Al Lowe